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Foreword

Foreword

The PMC SUG6 safety module adds the Safe Torque Off (STO) and Safe Stop 1 (SS1) safety
functions, both described as standard in EN 61800-5-2, to drive controllers of the PMC SC6 and PMC
SI6 series.

STO prevents an electrical rotating magnetic field, needed for the operation of synchronous or
asynchronous motors, from being generated in a drive controller immediately once the safety function
has been activated. In the case of SS1-t, the switch-off happens after a configurable amount of time.

For a combination consisting of a drive controller and PMC SU6 safety module, the STO and SS1
safety functions are actuated via PROFINET (PROFIsafe).

PMC SU6 is a fast and wear-free fully electronic solution. The safety module is designed so that
regular system tests that interrupt operation are eliminated. In practical terms, this means increased
availability of machines and systems. The often complex planning and documentation of function
tests are also eliminated.

Drive controllers with an integrated safety module can be used in systems with high safety
requirements up to SIL 3, PL e, category 4. Compliance with standard requirements has been
certified by an independent testing institute as part of type-examination.

The PMC SC6 and PMC SI6 series drive controllers successfully passed the conformance tests for
PROFINET, PROFIsafe and PROFIdrive. This means that the communication interface was tested to
ensure the reliability and function of the lower-level communication regardless of vendor.

Manual PMC SU6 safety module Pilz| 5
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User information

2

2.1

2.2

2.3

24

2.5

2.6

User information

This documentation provides all information on the intended use of the drive controller in combination
with the PMC SUG6 safety module.

Storage and transfer

As this documentation contains important information for handling the product safely and efficiently, it
must be stored in the immediate vicinity of the product until product disposal and be accessible to
qualified personnel at all times.

Also pass on this documentation if the product is transferred or sold to a third party.

Described product
This documentation is binding for:

Drive controllers of the PMC SC6 or PMC SI6 series in combination with the PMC SU6 safety module
and DriveControlSuite (DS6) software in V 6.7-A or later and associated firmware in V 6.7-A-PN or
later.

Standards
The following standards are relevant to the product specified in this documentation:
EN ISO 13849-1:2015
EN ISO 13849-2:2012
EN 61800-5-2:2017
EN 61508-x:2010
EN 60204-1:2018
EN 62061:2005 + Cor.:2010 + A1:2013 + A2:2015
IEC 61784-3:2016

Subsequent references to the standards do not specify the respective year in order to improve
readability.

Timeliness

Check whether this document is the most up-to-date version of the documentation. We make the
latest document versions for our products available for download on our website:
https://www.pilz.com/en-INT.

Original language

The original language of this documentation is German; all other language versions are derived from
the original language.

Limitation of liability

This documentation was created taking into account the applicable standards and regulations as well
as the current state of technology.

No warranty or liability claims for damage shall result from failure to comply with the documentation or
from use that deviates from the intended use of the product. This is especially true for damage
caused by individual technical modifications to the product or the project configuration and operation
of the product by unqualified personnel.

Manual PMC SU6 safety module Pilz | 6
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2.7

2.71

Formatting conventions

Orientation guides in the form of signal words, symbols and special text markups are used to
emphasize specific information so that you are able identify it in this documentation quickly.

Display of warning messages and information

Warning messages are identified with symbols. They indicate special risks when handling the product
and are accompanied by relevant signal words that express the extent of the risk. Furthermore, useful
tips and recommendations for efficient, error-free operation are specially highlighted.

> B b B

ATTENTION!

Attention indicates that damage to property may occur

= if the stated precautionary measures are not taken.

CAUTION!

Caution with a warning triangle indicates that minor personal injury may occur

= if the stated precautionary measures are not taken.

WARNING!

Warning with a warning triangle means there may be a considerable risk of fatal
injury

= if the stated precautionary measures are not taken.

DANGER!

Danger with a warning triangle indicates that there is a considerable risk of fatal
injury
= if the stated precautionary measures are not taken.

Information

Information indicates important information about the product or serves to

emphasize a section in the documentation that deserves special attention from the

reader.

Manual PMC SU6 safety module
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User information

2.7.2

2.7.3

Markup of text elements

Certain elements of the continuous text are distinguished as follows.

Important information

Words or expressions with a special meaning

Interpolated position mode

Optional: File or product name or other name

Detailed information

Internal cross-reference

http://www.samplelink.com

External cross-reference

Software and other displays

The following formatting is used to identify the various information content of elements referenced by
the software interface or a drive controller display, as well as any user entries.

Referencing method A

Main menu Window names, dialog box names, page names or

Settings buttons, combined proper nouns, functions referenced by
the interface

Select Predefined entry

Save your
<own IP address>

User-defined entry

EVENT 52:
COMMUNICATION

Displays (status, messages, warnings, faults)

Keyboard shortcuts and command sequences or paths are represented as follows.

[CTRL], [CTRL] + [S]

Key, key combination

Table > Insert table

Navigation to menus/submenus (path specification)

Mathematics and formulas

The following signs are used to represent mathematical relationships and formulas.

- Subtraction
+ Addition

x Multiplication
+ Division

|| Absolute value

Manual PMC SU6 safety module
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2.8

2.9

Trademarks

The following names used in connection with the device, its optional equipment and its accessories

are trademarks or registered trademarks of other companies:

PROFIBUS®,
PROFINET®

PROFIdrive®,
PROFIlsafe®

SIMATICS,
TIA Portal®

PROFIBUS® and PROFINET® are registered trademarks of
PROFIBUS Nutzerorganisation e.V., Germany.

PROFIdrive® and PROFIsafe® are registered trademarks of Siemens

AG, Germany.

SIMATIC® and TIA Portal® are registered trademarks of Siemens AG,

Germany.

All other trademarks not listed here are the property of their respective owners.

Products that are registered as trademarks are not specially indicated in this documentation. Existing
property rights (patents, trademarks, protection of utility models) are to be observed.

Explanation of terms

As relevant standards and products of other manufacturers are referenced, different manufacturer- or
standard-specific names are used for the same term in this documentation.

For improved understandability, the names in this documentation are standardized to the terminology
of Pilz to the greatest extent possible. The correlation of Pilz names to other sources can be found in

the following table.

Pilz PROFINET PROFIsafe
Controller 10 controller F-CPU, F-host
Drive controller 10 device F-device, F-slave

Tab. 1: Correlation of Pilz terminology to PROFINET and PROFIsafe

Manual PMC SU6 safety module
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Safety notes

3 Safety notes

WARNING!

Risk of fatal injury if safety notes and residual risks are not observed!

Failure to observe the safety notes and residual risks in the drive controller
documentation may result in accidents causing serious injury or death.

= Observe the safety notes in the drive controller documentation.

= Consider the residual risks in the risk assessment for the machine or system.

WARNING!

Malfunction of the machine due to incorrect or modified parameterization!

In the event of incorrect or modified parameterization, malfunctions can occur on
machines or systems which can lead to serious injuries or death.

= Observe the security notes in the drive controller documentation.
= Protect the parameterization, e.g. from unauthorized access.

= Take appropriate measures for possible malfunctions (e.g. emergency off or
emergency stop).

3.1 Qualified personnel

In order to be able to perform the tasks described in this documentation, the persons instructed to
perform them must have the appropriate professional qualification and be able to assess the risks and
residual hazards when handling the products. For this reason, all work on the products as well as
their operation and disposal may be performed only by professionally qualified personnel.

Qualified personnel are persons who have acquired the authorization to perform these activities either
through training to become a specialist and/or instruction by specialists.

Furthermore, valid regulations, legal requirements, applicable basic rules, this documentation and the
safety notes included in it must be carefully read, understood and observed.

Manual PMC SU6 safety module Pilz| 10
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Safety notes

3.2 Intended use

The PMC SUG6 safety module can be combined with Pilz drive controllers of the PMC SC6 or PMC
SI6 series.

If a drive controller with the integrated PMC SUG6 safety module is used in a safety-related application,
the safety module must be activated by a safety relay or a safety controller.

DANGER!

Electrical voltage! Risk of fatal injury due to electric shock!

An active STO safety function only means that generation of the rotating magnetic
field at the motor has been interrupted. The motor may still be energized with
dangerous high voltages.

= Make sure that persons cannot come into contact with conductive parts.

= If the supply voltage must be switched off, observe the requirements of
EN 60204-1.

Improper use

The safety module may not be operated outside of the drive controller or operated not in compliance
with the applicable technical specifications.

Py Information

I An emergency off in accordance with EN 60204-1 is not possible with the PMC SU6

safety module!
Observe this standard regarding the difference between emergency off and
emergency stop in conjunction with Safe Torque Off.

Modification

As the user, you may not make any technical or electrical modifications to the PMC SU6 safety
module. Any removal of the module from the drive controller as well as any attempt at repair or
replacement is prohibited.

Maintenance

The safety module does not require maintenance.

3.3 Decommissioning

In safety-oriented applications, note the mission time Ty, = 20 years in the safety-relevant key
performance indicators. A drive controller with integrated safety module must be taken out of
operation 20 years after the production date. The production date of the drive controller is found on
the accompanying nameplate.

Manual PMC SUG6 safety module Pilz | 11
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Safety module PMC SU6

4 Safety module PMC SU6

The PMC SUG6 safety module adds the STO (Safe Torque Off) and SS1 (Safe Stop 1) safety functions
to the drive controller. The module prevents the formation of a rotating magnetic field in the power unit
of the drive controller and, in the event of an error or by external request, switches the drive controller
to the STO state immediately or after a time delay (SS1-t).

Features

Possible safety functions:
» Safe Torque Off — STO in accordance with EN 61800-5-2
» Stop category 0 in accordance with EN 60204-1
» Safe Stop 1 (time-delayed) — SS1-t in accordance with EN 61800-5-2
» Stop category 1 in accordance with EN 60204-1

Activation of the safety functions using PROFIsafe
STO switch-off time: < 60 ms

Free of wear

Certifications in accordance with EN 61800-5-2 and EN ISO 13849-1
Safety Integrity Level (SIL) 3
Performance Level (PL)e

Category 4

Manual PMC SUG6 safety module Pilz| 12
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System design and function

5 System design and function

Drive controller (F-device)
with integrated safety technology - PDS(SR)

Control unit
=1 — [
C ller z Motion Control
ontro Z -
| H-{ L
(F-host) é —_ Application core cascade
o | PROFlsafe
|
I Y\
=| 38 =
! 2| g =
i e o
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Fig. 1: Components of the PROFIsafe-based safety concept

System components
Central components of the PROFIsafe-based safety concept are:

Drive controller (F-device) with integrated PMC SU6 safety module
... for implementing the STO and SS1-t safety functions

Controller (F-host) with integrated F-CPU

... for organizing all network communication

... for PROFIsafe communication and logic gate links between PROFIsafe nodes; the safety
controller includes certified safety function modules that can be configured to the specific
application using suitable automation software

PROFIsafe protocol
... for the transmission of safety-related data

PROFINET
... as the underlying fieldbus system

Manual PMC SU6 safety module Pilz| 13
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System design and function

Function

The control unit of the drive controller generates pulse patterns (PWM) to produce a rotating magnetic
field at the IGBT module in the power unit. This rotating magnetic field is necessary for operating
synchronous and asynchronous motors.

If the STO safety function is not active, the PMC SU6 safety module allows for the generation of a
rotating magnetic field in the power unit; the connected motor can create a rotating magnetic field. If
the safety function is active, the PMC SUG6 safety module disables the generation of the rotating
magnetic field in the power unit and the drive controller cannot generate any torque in the connected
motor.

The drive controller exchanges control and status information with the PROFIsafe controller via the
PMC SUG6 safety module in accordance with the black channel principle. The drive controller extracts
the safety-related data, checks it for plausibility and enables or disables the two safety channels in the
power unit.

The STO and SS1-t safety functions relate to the device and are not axis-specific. On double-axis
controllers, both axes are brought to a safe state at the same time. An activated SS1-t cannot be
interrupted.

DANGER!

Risk of fatal injury due to gravity-loaded vertical axes or motor coasting!

The drive controller in the motor cannot generate torque when the STO safety
function is active. Consequently, vertical axes subject to gravitational forces may fall.
If the motor is moving when STO is activated, it will coast uncontrolled.

= Secure gravity-loaded vertical axes by braking or taking similar actions.

= Make sure that the motor coasting does not create any hazards.

WARNING!

Increased overrun distance! Residual motion!

The safety module cannot prevent a failure of the functional part of the drive
controller (e.g. during a controlled stop) while the SS1-t safety function is executed.
Therefore, SS1-t cannot be used if this failure could cause a dangerous situation in
the end application. Observe this during project configuration.

In the event of an error in the power unit of the drive controller, static energization of
the motor is possible despite active STO. In this case, the motor shaft can move by
an angle of up to 360° + (p x 2).

Manual PMC SUG6 safety module Pilz| 14
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Technical data

6 Technical data

The transport, storage and operating conditions of the safety module correspond to those of the drive
controller. The technical data is part of the drive controller manual (see Further information [[L[]

69]).
The following table contains the key figures relevant to safety technology for the PMC SU6 safety
module.

SIL CL 3

SIL 3

PL e

Category 4

PFHD 5x10° [1/n]

Mission time (TM) 20 years

STO switch-off time <60 ms

SS1 delay time 10 — 655350 ms (+ 1%)

Tab. 2: PMC SUG6 — Key safety-related figures

® Information

I The cycle time of the PMC SU6 safety module is 12 ms, during which deactivation
by SS1-t takes place in a 12 ms pattern and an additional delay of up to 10 ms can
occur.

With a SS1 delay time of 10 ms (50 ms), the axis is stopped after 12 ms (60 ms).

Manual PMC SU6 safety module Pilz| 15
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What you should know before commissioning

7

What you should know before commissioning

The following chapters provide a quick introduction to the structure of the program interface and
accompanying window designations as well as relevant information about parameters and generally
saving your project configuration.

71 Program interfaces
The following chapters include an overview of the program interfaces for the described software
components.
711 DS6 program interface
Using the graphical interface of the DriveControlSuite commissioning software (DS6), you can project,
parameterize and commission your drive project quickly and efficiently. In case of service, you can
evaluate diagnostic information such as operating states, fault memories and fault counters of your
drive project using DriveControlSuite.
Information
I The program interface of DriveControlSuite is available in German, English and
French. To change the language of the program interface, select Settings >
Language.
® Information
I The DriveControlSuite help in the menu bar can be reached via Help > Help for DS6
or via the [F1] key on your keyboard. When you press [F1] in an area of the program,
the corresponding help topic opens.
Manual PMC SUG6 safety module Pilz | 16
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What you should know before commissioning

Fig. 2: DS6: Program interface

1 Menu bar Using the File, View, Settings and Window menus, you can open and
save projects, display and hide program windows, select the interface
language and access level and change between different windows in the
workspace.

2 Toolbar The toolbar enables quick access to frequently needed functions, like

opening and saving projects and hiding and displaying windows in the
program interface.

3 Project tree

The project tree forms the structure of your drive project in the form of
modules and drive controllers. Select an element using the project tree
first in order to edit it using the project menu.

4 Project menu

The project menu offers you various functions for editing the project,
module and drive controller. The project menu adapts to the element that
you selected in the project tree.

5 Workspace

The different windows which can be used to edit your drive project, such
as the configuration dialog, wizards, the parameter list or the scope
analysis tool, open in the workspace.

6 Parameter check

The parameter check points out irregularities and inconsistencies that
were detected in the plausibility check of calculable parameters.

parameter lists

7 Messages The entries in the messages log the connection and communication
status of the drive controllers, incorrect inputs caught by the system,
errors when opening a project or rule violations in the graphical
programming.

8 Variable You can use variable parameter lists to compile any parameters in

individual parameter lists for a quick overview.

9 Status bar

In the status bar, you can find the specifications of the software version
and get additional information about the project file, the devices and the
progress of the process during processes such as loading projects.

Manual PMC SUG6 safety module
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What you should know before commissioning

7111 Configuring the view

In DriveControlSuite, you can change the visibility and arrangement of areas and windows, such as to
optimize the available space in the workspace when working with smaller screens.

Showing/hiding areas

Use the icons in the toolbar or the items in the View menu to show or hide specific areas in
DriveControlSuite as needed.

Icon Item Description
- Reset Resets the view to factory settings.
‘E% Project Shows/hides the Project window (project tree,
project menu).
é Messages Shows/hides the Messages window.
4 Parameter check Shows/hides the Parameter check window.

<

Variable parameter Shows/hides the Variable parameter lists

# lists window.

Arrange and group areas

You can undock and rearrange the individual areas via drag and drop. If you drag an undocked
window to the edge of DriveControlSuite, you can release it there in a color-highlighted area either
next to or on top of another window to redock it.

When you release the window onto another window, the two areas are merged into one window
where you can use tabs to switch between the areas.
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71.1.2 Navigation using sensitive circuit diagrams
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Fig. 3: DriveControlSuite: Navigation using text links and symbols

In order to graphically illustrate the processing sequence of actual and set values, the use of signals
or the arrangement of drive components and to make configuring the accompanying parameters
easier, they are displayed on the respective wizard pages of the workspace in the form of circuit
diagrams.

Blue text links or clickable icons indicate links within the program. These refer to the corresponding
wizard pages and, as a result, allow you to reach additional helpful detail pages with a click.
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71.2 TIA Portal program interface

The Siemens Totally Integrated Automation Portal (TIA Portal) offers a platform you can use to
commission your PROFINET system. The TIA Portal is broken down into the portal view and the
project view.

TIA portal view

The TIA overall functionality is broken down into different task areas that you can reach using portals.
The following graphic shows the interface elements of the TIA portal view relevant to this
documentation.

B S

ol
Mo SO
Fig. 4: TIA Portal: Program interface of the portal view

1 Portal selection The portal selection offers you access to various portals for different
tasks and functions.

2 Portal functions Depending on the selected portal, the portal functions are available here.

3 Project view The button lets you change to the project view.
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TIA project view

The TIA project view offers you access to all components of a project. The following graphic shows
the TIA project view interface elements relevant to this documentation.

e @ 0@

4
6

Fig. 5: TIA Portal: Program interface of the project view

1 Project navigation

Project navigation offers you access to all components of your
TIA project.

2 Details view

The details view shows you additional information about a selected
object.

3 Workspace

In the workspace, you can edit objects in the topology view, network view
or device view, for example.

4 Inspector window

The inspector window shows you additional information about a selected
object.

5 Task cards

Task cards are available depending on the selected object and grant you
access to the hardware catalog, online tools, tasks or libraries, for
example.

6 Portal view

The button lets you change to the portal view.
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7.2 Meaning of parameters

You can use parameters to adapt the function of the drive controller to your individual application. In
addition, parameters visualize the current actual values (actual velocity, actual torque, etc.) and
trigger actions such as Save values, Test phase, etc.

Interpretation of parameter identification

Parameter identification consists of the following elements, where short forms are also possible,
i.e. only specifying a coordinate or the combination of coordinate and name.

E50| Drive controller | G6 | \[o)
| | |

Coordinate Name Version
Drive controller
generation/series
7.21 Parameter groups

Parameters are assigned to individual groups by topic. The drive controllers differentiate between the
following parameter groups.

©
B
[}
=
o

Topic

Drive controllers, communication, cycle times

Motor

Machine, velocity, torque/force, comparators

Set value

Display

Terminals, analog and digital inputs and outputs, brake

Technology — Part 1 (application-dependent)

IG)'”TT]UOUJ>

Encoder

Motion (all motion settings)

Motion blocks

Control panel

Technology — Part 2 (application-dependent)

Profiles (application-dependent)

Additional functions (application-dependent; e.g. extended cam control unit)

Customer-specific parameters (programming)

Customer-specific parameters, instance-dependent (programming)

A|lo|v|Z2|Z2|7 | X<

Production data for the drive controller, motor, brakes, motor adapter, gearbox and
geared motor

Safety (safety technology)

Scope

Protection functions

N|lCc|H|®»

Fault counter

Tab. 3: Parameter groups
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7.2.2 Parameter types and data types

In addition to topic-based sorting in individual groups, all parameters belong to a certain data type and
parameter type. The data type of a parameter is displayed in the parameter list, properties table. The
connections between parameter types, data types and their value range can be found in the following

table.

(single type according
to IEE754)

signed)

Data type Parameter type Length Value range
(decimal)
INT8 Integer or selection 1 byte (signed) -128 — 127
INT16 Integer 2 bytes (1 word, -32768 — 32767
signed)
INT32 Integer or position 4 bytes (1 double word, | -2 147 483 648
signed) —2 147 483 647
BOOL Binary number 1 bit (internal: 0,1
LSB in 1 byte)
BYTE Binary number 1 byte (unsigned) 0-255
WORD Binary number 2 bytes (1 word, 0 -65535
unsigned)
DWORD Binary number or 4 bytes (1 double word, | 0 — 4 294 967 295
parameter address unsigned)
REAL32 Floating-point number | 4 bytes (1 double word, | -3.40282 x 103

—3.40282 x 10%

STR8 Text 8 characters —
STR16 Text 16 characters —
STR80 Text 80 characters —

Tab. 4: Parameters: Data types, parameter types, possible values

Parameter types: Use

Integer, floating-point number
For general computing processes
Example: Set and actual values

Selection

Numeric value to which a direct meaning is assigned
Example: Sources for signals or set values

Binary number

Bit-oriented parameter information that is collected in binary
Example: Control and status words

Position

Integer combined with associated units and decimal places
Example: Actual and set values of positions

Velocity, acceleration, deceleration, jerk
Floating-point number combined with associated units
Example: Actual and set values for velocity, acceleration, deceleration, jerk

Parameter address

Referencing of a parameter
Example: In F40 AO1 source, for example, EO8 n-motor filtered can be parameterized

Text

Outputs or messages

Manual PMC SU6 safety module
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7.2.3

7.24

Parameter types

The following types of parameters are differentiated.

Parameter type

Description

Example

Simple parameters

Consist of one group and one line
with a defined value.

A21 Brake resistor R: Value =
100 ohms

Array parameters

Consist of a group, a line and
multiple sequential (listed)
elements, which have the same
properties but different values.

A10 Access level

A10[0] access level: Value =
Access level via operating unit

A10[2] access level: Value =
Access level via CANopen and
EtherCAT

A10[4] access level: Value =
Access level via PROFINET

Record parameters

Consist of a group, a line and
multiple sequential (listed)
elements, which can have different
properties and different values.

A00 Save values
AO0Q[0] Start: Value = Start action

AO00[1] Progress: Value = Display
action progress

A00[2] Result: Value = Display
action result

Tab. 5: Parameter types

Parameter structure

Every parameter has specific coordinates with the following structure.

1. E250[2] .3

=T
Line
Group  Element
Axis Bit

Axis (optional)

In case of multiple axes, the one to which a parameter is assigned; not applicable for global
parameters (value range: 1 — 4).

Group

The thematic group to which a parameter belongs (value range: A — Z).

Line

Distinguishes the parameters within a parameter group (value range: 0 — 999).

Element (optional)

Elements of an array or record parameter (value range: 0 — 16000).

Bit (optional)

Selection of a single bit for complete data addressing; depends on the data type

(value range: 0 — 31).
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7.2.5 Parameter visibility
The visibility of a parameter is controlled by the access level you set in DriveControlSuite and by the
properties you project for the respective drive controller (e.g. hardware, firmware and application). A
parameter can also be shown or hidden depending on other parameters or settings. For example, the
parameters of an additional function are only shown as soon as you activate the relevant additional
function.
Access level
The access options for the individual software parameters are ranked hierarchically and divided into
individual levels. This means that parameters can be hidden for a specific purpose and, relatedly,
their configuration options can be locked starting from a specific level.
Each parameter has one access level for read access (visibility) and one access level for write access
(editability). The following levels are present:
Level O
Elementary parameters
Level 1
Important parameters of an application
Level 2
Important parameters for service with extensive diagnostic options
Level 3
All parameters needed for commissioning and optimizing an application
The parameter A10 Access level controls general access to parameters:
Over CANopen or EtherCAT (A10[2])
Over PROFINET (A10[3])
® Information
I It is not possible to write to or read the parameter hidden in DriveControlSuite during
communication via fieldbus.
Hardware
Which parameters are available to you in DriveControlSuite is determined by which series you select
in the configuration dialog for the drive controller, for example, or whether you project an option
module. Basically, the only parameters that are displayed are the ones you need to parameterize the
configured hardware.
Firmware
Due to the further development and updating of functions for the drive controllers, new parameters
and also new versions of existing parameters are continuously being implemented in
DriveControlSuite and in the firmware. The parameters are displayed in the software according to the
DriveControlSuite version used and the configured firmware version of the respective drive controller.
Applications
Applications generally differ in terms of functions and their control. For this reason, different
parameters are available with each application.
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7.3

Signal sources

Drive controllers are controlled either by a fieldbus, by terminals or by mixed operation consisting of a
fieldbus system and terminals. You can use the corresponding selection parameters, referred to as
signal sources, to configure in DriveControlSuite whether the control signals and set values of the
application are obtained over a fieldbus or using terminals.

In case of activation by using terminals, the respective analog or digital inputs are specified directly as
the source. In case of activation by fieldbus, parameters are selected as sources for control signals
and set values, which must be part of the process data mapping between the controller and drive
controller so that the controller can write to them via fieldbus.

7.4 Non-volatile memory
All project configurations, parameterizations and related changes to parameter values are in effect
after transmission to the drive controller, but are only stored in volatile memory.
Saving to a drive controller
To save the configuration in non-volatile memory on a drive controller, you have the following options:
Saving the configuration using the Save values wizard:
Project menu > Wizards area > Projected axis > Save values wizard: Select the Save values
action
Saving the configuration using the parameter list:
Project menu > Parameter list area > Projected axis > Group A: Drive controller > AO0 Save
values: Set the parameter A00[0] to the value 1: Active
Saving the configuration using the S1 operating button:
Drive controller with S1 operating button: Press and hold the operating button for 3 s
Saving to all drive controllers within a project
To save the configuration in non-volatile memory on several drive controllers, you have the following
options:
Saving the configuration using the toolbar:
Toolbar > Save values icon: Click the Save values icon
Saving the configuration using the Online functions window:
Project menu > Online connection button > Online functions window: Click on Save values (A00)
® Information
I Do not shut off the drive controller while saving. If the supply voltage to the control
unit is interrupted while saving, the drive controller will start with the last correct
configuration that was saved and with fault 40: Invalid data the next time it is
switched on. In order to acknowledge the fault and successfully complete the saving
process, the configuration must be stored again in non-volatile memory and the
action must be completed.
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8

Commissioning

The following chapters describe the commissioning of your drive controller with integrated PMC
SUG6 safety module using DriveControlSuite in combination with TIA Portal and SIMATIC STEP 7
Safety from Siemens AG.

We assume the following system environment as an example so that you can follow the individual
commissioning steps exactly:

Drive controller of the PMC SC6 or PMC SI6 series in firmware version V 6.7-A-PN or later with
integrated PMC SU6 safety module

DriveControlSuite commissioning software version 6.7-A or later
in combination with
Siemens controller SIMATIC S7-1500F with Safety Integrated
Siemens Totally Integrated Automation Portal (TIA Portal) V16 automation software
Siemens SIMATIC STEP 7 Safety Basic / Advanced options package for TIA Portal V16

Commissioning focuses on the essential steps for the SU6 safety module and PROFIsafe
communication. For more information on commissioning the fieldbus communication and application,

refer to the relevant manual (see Further information [[_L] 69]).

Commissioning is divided into the following steps:

1. PMC SU6 safety module
Enter a valid PROFIsafe destination address using S12 DIP switches.

2. Observe the time setting recommendations for the following configuration.

3. DriveControlSuite:
Project all drive controllers in your PROFINET network (device control, application and process
data), parameterize the general PROFINET settings as well as the PZD transmission if
applicable, calculate the checksum for PROFIsafe communication, and then transmit your
configuration to the drive controllers of your PROFINET network.

4. TIA Portal:
Next, map your actual PROFINET network in TIA Portal and configure the individual nodes.
Transfer the configuration to the controller and start up your PROFINET network. Then, check
the PROFIsafe communication of the nodes.

5. Configure the safety functions, check them and document the results in a test report.

Information

I Before you start commissioning your PROFINET network using DriveControlSuite
and TIA Portal, you must network all nodes of your PROFINET network with each
other.

Information

Always perform the steps described below in the specified order!

Some parameters are interdependent and do not become accessible to you until you
have first configured certain settings. Follow the steps in the specified sequence so
that you can finish the parameterization completely.
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8.1

8.2

PMC SUG6: Assign the PROFIsafe destination address

In order to be able to identify the PMC SU6 safety module in the PROFIsafe network, you must
assign it a unique address in the PROFIsafe network. The address is based on values from the DIP
switches on the top of the drive controller that are switched to ON. For more information on this, see

PMC SU6: Assign the PROFIsafe destination address [[L] 66].

Py Information

I The drive controller must be switched off before you assign the address for the PMC
SUG6 safety module using the S12 DIP switches. The drive controller has to be
restarted to apply the address.

Recommended time settings

In the event of a quick stop with a subsequent STO (stop category 1 in accordance with DIN EN
60204-1 or Safe Stop 1 (SS1-t) in accordance with DIN EN 61800-5-2) or in the event of a controlled
axis stop, the communication is interrupted and the power unit may be deactivated prematurely. In
this case, axis movement can no longer by controlled by the drive controller.

In order to prevent premature deactivation of the power unit, you must take the delay time for the
quick stop (quick stop time) into account when parameterizing the SS1 delay time.

Quick stop time

The quick stop time is an application-specific result of the quick stop deceleration and maximum
velocity. Parameterize the maximum velocity in 110 Maximal speed. In Drive Based or PROFIdrive
applications, parameterize the quick stop deceleration in 117 Quickstop deceleration.

SS1 delay time

In TIA Portal, set a larger value for SS1 Delay Time in the device configuration of the safety module
than for the resulting quick stop time. The reserve should generally be 10% and should not fall below
50 ms. You can check the SS1 delay time in S47 PROFIsafe SS1-time.

PROFIsafe watchdog time

In the device configuration of the safety module in TIA Portal, set a sufficiently large value for the
watchdog time F_\WD_Time to prevent unintentional false triggering (e.g. due to a cycle time that is
too slow) or fault 70: Parameter consistency with cause 15.

The watchdog time F_\WD_Time configured in the controller is displayed in DriveControlSuite in
parameter S46.

Note the following condition:

S46 PROFIsafe watch dog time > A109 PZD-Timeout + S44 PROFIsafe data bus turnaround time +
26 ms

For more information on the watchdog time, see Watchdog time [[L[]|67].

Manual PMC SU6 safety module Pilz | 28

1006910-en-US-02



Commissioning

8.3 DS6: Configuring the drive controller

Project and configure all drive controllers for your drive system using DriveControlSuite.

8.3.1 Initiating the project

In order to be able to configure all drive controllers and axes of your drive system using
DriveControlSuite, you must record them as part of a project.

8.3.1.1 Projecting the drive controller and axis

Create a new project and project the first drive controller along with the accompanying axis.

® Information

I Make sure that you project the correct series in the Drive controller tab. The
projected series cannot be changed afterwards.

Creating a new project
1. Start DriveControlSuite.
2. On the start screen, click Create new project.

= The new project is created and the configuration dialog for the first drive controller opens.

= The Drive controller button is active.

® Information

I The PMC SUG6 safety module is compatible with PROFIdrive device control and
applications as well as Drive Based device control and applications.

Projecting the drive controller

1. Properties tab:
Establish the relationship between your circuit diagram and the drive controller to be projected in
DriveControlSuite.

1.1. Reference:
Define the reference code (equipment code) of the drive controller.

1.2. Designation:
Give the drive controller a unique name.

1.3. Version:
Version your project configuration.

1.4. Description:
If necessary, save additional supporting information (e.g., the change history).

2. Drive controller tab:
Select the series, device type and firmware version of the drive controller.

2.1. Firmware:
Select the PROFINET version 6.x -PN.

3. Option modules tab, Safety module:
Select the PMC SUG6 safety module.
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4. Device control tab:
Project the basic control of the drive controller.

4.1. Device control:
Select the device control that defines the underlying activation signals of the drive
controller.

4.2. Rx process data, Tx process data:
Select PROFINET Rx and PROFINET Tx for transmitting PROFINET process data.

Projecting the axis
1. Click Axis A.

2. Properties tab:
Establish the relationship between your circuit diagram and the axis to be projected in
DriveControlSuite.

2.1. Reference:
Define the reference code (equipment code) of the axis.

2.2. Designation:
Give the axis a unique name.

2.3. Version:
Version your project configuration.

2.4. Description:
If necessary, save additional supporting information (e.g., the change history).

3. Application tab:
Select the desired controller-based or drive-based application.

4. Motor tab:
Select the type of motor you operate with this axis. If you are working with motors from third-
party suppliers, enter the accompanying motor data later.

5. Repeat the steps for axis B (only for double-axis controllers).

6. Confirm with OK.
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8.3.2

8.3.3

Parameterizing general PROFINET settings

v" You have projected the PROFINET Rx and PROFINET Tx process data for the drive controller.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in
the Project menu > Wizard area.

2. Select the PROFINET wizard.

3. A100 Fieldbus scaling:
Leave the default value at 1: Native (values are passed unchanged).

4. A273 PN device name:
Elements [0] to [2] show the PROFINET device name that was assigned in TIA Portal if there is
an online connection between the drive controller and controller.
In elements [3] to [5], you have the option to enter the device name. This eliminates the need to
assign the device name in TIA Portal.

5. A109 PZD-Timeout:
Define the time that results from the tolerated failure time for monitoring the PZD communication
plus the watchdog time of the controller (TIA Portal: watchdog time) in the PROFINET network
(default value: 20 ms).

Configuring PZD transmission

The PZD channel (process data transmission channel) serves to transfer control and status
information as well as actual and set values between a controller (IO controller) and drive controller
(IO device) cyclically in real time. The direction of data flow is important in this data exchange. From
the perspective of the drive controller, PROFINET distinguishes between receive PZD (RxPZD) and
transmit PZD (TxPZD). Pilz drive controllers support a flexible assignment of the parameter values to
be transmitted.

You can transfer process data with a maximum of 48 parameters to be transferred over axes A and B
(24 per axis).
The planned projected application determines which process data is exchanged between the

controller and drive controller during cyclical data transmission.

In the PROFIdrive application, process data mapping takes place automatically when the connection
between the controller and drive controller is established and depends on the selected telegram;
manual parameterization is not required.

In Drive Based applications, the process data is pre-assigned accordingly by the standard mapping.
Check the standard mapping and adjust it if necessary.

For more information on the supported communication objects of the PROFIdrive profile or the
standard mapping of Drive Based applications, refer to the relevant application manual.
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8.34 Calculating checksum F_iPar_CRC

Use DriveControlSuite to calculate checksum F_iPar_CRC for PROFIsafe communication, which you
need for the device configuration of the PMC SU6 safety module in TIA Portal.

v" You have projected the PMC SU6 safety module for the drive controller in question.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in
the Project menu > Wizard area.

2. Select the PROFINET wizard > Calculate F_iPar-CRC: PROFI|safe.

3. SS1 Delay Time:
Enter the SS1 delay time as a multiple of 10 ms.

Click on Calculate.

= Checksum F_iPar_CRC is calculated.

® Information

I Enter the SS1 delay time as a multiple of 10 ms. An SS1 Delay Time of 100
corresponds to 1s (100 x 10 ms = 1 s).

Assign a larger value for SS1 Delay Time than for the quick stop time of the drive
controller. The reserve should generally be 10% and should not fall below 50 ms.

Information

You need checksum F_iPar_CRC for PROFIsafe communication. Calculate the
checksum based on the SS1 delay time in DriveControlSuite and transmit
F_iPar_CRC to the parameter of the same name in TIA Portal when configuring the
safety module.

If you make changes to the SS1 delay time, you must recalculate F_iPar_CRC and
store it in the device configuration of the safety module in TIA Portal.
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8.3.5 Transmitting and saving the configuration

In order to transmit and save the configuration to one or more drive controllers, you must connect
your PC and the drive controllers over the network.

WARNING!

Injury to persons and material damage due to axis movement!

If there is an online connection between DriveControlSuite and the drive controller,
changes to the configuration can lead to unexpected axis movements.

= Only change the configuration if you have visual contact with the axis.
= Make sure that no people or objects are within the travel range.

= For access via remote maintenance, there must be a communication link
between you and a person on site with eye contact to the axis.

Information

During the search, all drive controllers within the broadcast domain are found via
IPv4 limited broadcast.

Requirements for finding a drive controller in the network:
= Network supports IPv4 limited broadcast

= All drive controllers and the PC are in the same subnet (broadcast domain)

v’ The drive controllers are switched on and can be found in the network.

1. In the project tree, select the module under which you have recorded your drive controller and
click Online connection in the project menu.

= The Add connection dialog box opens. All drive controllers found via IPv4 limited broadcast
are displayed.

2. Direct connection tab, |P address column:
Activate the IP addresses in question and confirm your selection with OK.

= The Online functions window opens. All drive controllers connected through the selected IP
addresses are displayed.

3. Select the module and the drive controller to which you would like to transfer the configuration.
Change the selection of transmission type from Read to Send.

4. Change the selection Create new drive controller:
Select the configuration that you would like to transfer to the drive controller.

5. Repeat steps 3 and 4 for all other drive controllers to which you would like to transfer your
configuration.

6. Online tab:
Click Establish online connections.

= The configurations are transferred to the drive controllers.
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Saving a configuration

v" You have successfully transferred the configuration.

1. Online functions window, Online tab, Actions for drive controller in online operation area:
Click Save values (A00).

= The Save values (A00) window opens.
2. Select on which drive controllers you want to save the configuration.
3. Click Start action.
= The configuration is stored on the drive controllers in non-volatile memory.

4. Close the Save values (A00) window.

® Information

I For the configuration to take effect on the drive controller, a restart is required: for
example, after the configuration is saved on the drive controller for the first time or
when changes are made to the firmware or process data mapping.

Restarting a drive controller

v" You have stored the configuration on the drive controller in non-volatile memory.

1. Online functions window, Online tab:
Click Restart (A09).

= The Restart (A09) window opens.
2. Select which of the connected drive controllers you want to restart.
3. Click Start action.

4. Confirm the safety note with OK.

= The Restart (A09) window closes.

= The fieldbus communication and connection between DriveControlSuite and drive controllers are
interrupted.

= The selected drive controllers restart.

Manual PMC SU6 safety module Pilz | 34
1006910-en-US-02



Commissioning

8.3.6 Testing the configuration

After you have transferred the configuration to the drive controller, first check your projected axis
model and the parameterized electrical and mechanical data for plausibility before continuing with the
parameterization.

® Information

I Make sure that the values of the control panel are compatible with your projected
axis model in order to obtain useful test results that you can use to optimize your
configuration for the respective axis.

The scaling calculator is available under the Axis model wizard > Axis: Scaling to
recalculate the values for the control panel according to your projected axis model.

WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the
motions of the axis. If you are using a controller, it no longer monitors the axis
movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is
deactivated, which can cause unexpected axis movements.

= Do not switch to other windows when the control panel is active.
= Only use the control panel if you have visual contact with the axis.
= Make sure that no people or objects are within the travel range.

= For access via remote maintenance, there must be a communication link
between you and a person on site with eye contact to the axis.
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Testing the configuration using the jog control panel

v

There is an online connection between DriveControlSuite and the drive controller.

v" You have successfully stored the configuration on the drive controller.

v" No safety function is active.

1.

Select the relevant drive controller in the project tree and click on the desired projected axis in

the Project menu > Wizard area.
Select the Jog control panel wizard.

Click Control panel on and then Enable.

= The axis is monitored via the active control panel.

Check the default values of the control panel and adjust them to your projected axis model if

necessary.

To test the configuration of your projected axis for direction of motion, velocity, etc., move
axis gradually using the Jog+, Jog-, Jog step+ and Jog step- buttons.

Use your test results to optimize your configuration as necessary.

To deactivate the control panel, click on Control panel off.

® Information

I Jog+ and Jog- cause a continual manual movement in the positive or negative
direction. Jog step+ and Jog step- move the axis relative to the current actual
position by the increment specified in 114.

Jog+ and Jog- have a higher priority than Jog step+ and Jog step-.

the
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8.4

TIA Portal: Configuring the safety technology

Project and configure the PROFIsafe-capable controller (F-host) and all PROFIsafe-capable drive
controllers (F-devices) of your drive system. To do so, install the required GSD file and map the
PROFIsafe-capable devices of your PROFINET network in a TIA project.

Then, configure the controller. Adjust the general PROFINET settings and configure the PROFIsafe
settings of the F-CPU.

In the next step, configure the drive controller. Adjust the general PROFINET settings, project the
PMC SUG6 safety module and configure its PROFIsafe settings.

Then, transfer the configuration to the controller and check the PROFIsafe communication. Then,
check the safety functions and document the results in a test report.

8.4.1 Installing the GSD file
To be able to map the Pilz drive controllers of your PROFINET network in your TIA project, you must
import and install a GSD file (general station description file) from Pilz in your TIA project. Pilz drive
controllers are available in the hardware catalog of your TIA project as STOBER field devices as soon
as the GSD file has been installed.
® Information
I If you have already downloaded a GSD file from the Pilz download area at an earlier
point, make sure that you are using the current version of the GSD file required.
v" You have downloaded the current version of the GSD file from the Pilz download area and saved
it locally.
v’ You have created a TIA project and are in the TIA project view.
1. In the menu bar, select Options > Manage general station description files (GSD).
= The Manage general station description files window opens.
2. Installed GSDs tab > Source path area:
Select the directory in which you have stored the GSD file from Pilz and confirm with OK.
= The GSD file is displayed in the Content of the imported path area.
3. Content of the imported path area:
Select the desired GSD file and click on Install.
= The GSD file is installed; the Pilz drive controllers are available in the hardware catalog.
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8.4.2 Projecting the PROFINET network

Map the controller and all drive controllers of your PROFINET network in a TIA project by selecting
the corresponding modules from the hardware catalog and incorporating them into the project.

8.4.21 Projecting the controller
Project the controller of your PROFINET network.

v" You have created a TIA project and installed the GSD file from Pilz.

v" You are in the TIA network view; the hardware catalog is open.

1. Hardware catalog:
Select Controller > SIMATIC S7-1500 > CPU and open the folder of the CPU type that belongs
to your controller.

Drag and drop the desired controller into the network view.

= The controller is incorporated into your TIA project.

® Information

I If you would like to use PROFIsafe, you must project a failsafe CPU (F-CPU). You
can identify an F-CPU in the hardware catalog by the yellow symbol and letter F in
the device name (e.g. CPU 1215FC).

8.4.2.2 Projecting the drive controller

Project all drive controllers of your PROFINET network.
v" You have created a TIA project and installed the GSD file from Pilz.

v~ You are in the TIA network view; the hardware catalog is open.

1. Hardware catalog:
Select Other field devices > PROFINET IO > Drives > STOBER ANTRIEBSTECHNIK GmbH &
Co. KG > STOBER ANTRIEBSTECHNIK > STOBER 6th generation drive controllers > SI6, SC6
double-axis controllers + PS + PD3 or SI6, SC6 single-axis controllers + PS + PD3.

2. Drag and drop the desired drive controller into the network view.
= The drive controller is incorporated into your TIA project.

3. Repeat steps 1 and 2 for all drive controllers of your PROFINET network.

® Information

1 To be able to project the PMC SU6 safety module and use PROFIsafe, you must
project a PROFIsafe-capable drive controller. You can identify a PROFIsafe-capable
drive controller in the hardware catalog by the addition of + PROFIsafe or + PS in
the device name.

Manual PMC SU6 safety module Pilz | 38
1006910-en-US-02



Commissioning

8.4.2.3 Linking the controller and drive controller logically
Establish a logical gate link between the controller and drive controllers in order to enable the
communication between the devices.
v" You have projected the controller and drive controllers.
v" You are in the TIA network view.
1. Click on the interface of the controller and drag a connection to the interface of the first drive
controller while holding the mouse button.
2. Repeat the process for all drive controllers of your PROFINET network.
= The controller and drive controllers of your PROFINET network are linked logically with each
other.
® Information
I To be able to link the controller and drive controllers with each other logically, you
must be in the TIA network view.
8.4.2.4 Connecting ports
If you want to implement a control in application class 4, you have to connect the ports of all nodes.
For other application classes, this step is optional.
In order for PROFIdrive to operate in application class 4, PROFINET must be in synchronous
operation mode. For synchronous operation via PROFINET IRT, you must define how all PROFINET
nodes are connected to each other in the connection topology. To do this, in the topology view,
specify the connection of each individual cable from device to device and the exact port.
v" You have logically linked the controller and drive controllers.
v’ You are in the TIA topology view.
1. Click on the port you want to connect and drag it to the destination port while holding down the
mouse button.
2. Repeat the process for all ports to be connected in your PROFINET network.
= You have created the port connections.
® Information
I With an existing online connection, you can compare the connections you have
created with your real cable connections. For more information on the topology
comparison, see the documentation from Siemens or the online help in TIA Portal.
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8.4.3 Configuring the controller
Configure the network addresses for the controller as needed.

Then, configure the safety-related settings. Make sure that the F-capability of the controller is
activated, check the PROFIsafe source address and configure the F-runtime group.

8.4.31 Configuring network addresses

As needed, you can change the IP address and subnet mask of the controller.

v’ You are in the TIA network view.

1. Double-click on the controller of your PROFINET network.

= This switches you to the respective device view; the Inspector window shows the device
properties.

2. Inspector window > General tab:
Select PROFINET interface > Ethernet addresses in the area navigation.

3. IP protocol area > Set IP address in the project:
If not set by default, activate this option and change the IP address and subnet mask of the
controller.

= The IP address and subnet mask of the controller are configured.

8.4.3.2 Configuring the PROFIsafe source address
Make sure that F-capability is activated for the controller (F-CPU) and check the PROFIsafe source
address.

v’ You have projected an F-CPU for your TIA project.

v" You are in the TIA network view.

1. Double-click on the controller of your PROFINET network.

= This switches you to the respective device view; the inspector window shows the device
properties.

2. Inspector window > General tab:
Select Fail-safety in the area navigation.
= The settings for fail-safety open.

3. F-activation area:
Make sure that the F-capability is activated.

4. F-parameter area > Upper limit for F destination address:
Define the value 254 as an upper limit for the PROFIsafe destination address.

5. F-parameter area > Central F-source address:
Make sure that a PROFIsafe source address is stored for the controller (default value: 1).

Py Information

1 In TIA Portal, make sure that the PROFIsafe source addresses of the F-CPU match
in the device configuration of the controller and in the device configuration of the
drive controller (controller: Central F-source address; drive controller:
F_Source_Add).
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8.4.3.3 Configuring the F-runtime group

The F-runtime group is responsible for managing and running the safety program and consists of at
least three F-blocks: the main safety block (F-FB), which contains the actual safety program; the
associated failsafe data block (F-DB); and the failsafe organization block (F-OB), which calls up the
main safety block cyclically. For the F-OB, configure the cycle time and priority with which the main
safety block is to be called up and define the cycle times for the monitoring of the F-runtime group by
the F-CPU of the controller.

® Information

I If you add an F-CPU to your project, STEP 7 Safety creates the F-blocks that you
need for an F-runtime group by default and adds them to the F-runtime group
automatically.

v’ You have projected a controller with an F-CPU for your TIA project.

v You are in the TIA network view.

1. Project navigation > Devices tab:
Open the Safety Administration Editor of the controller in question by double-clicking on Safety
administration.

= The Safety Administration Editor opens.

2. Safety Administration Editor:
Select F-runtime group in the area navigation.

3. Failsafe organization block area:
Parameterize the F-OB.

3.1. Eventclass:
Make sure that Cyclic interrupt is set as the event class for the F-OB to ensure that the
main safety block is called up in fixed intervals.

3.2. Cycle time:
Define a cycle time for the F-OB which is smaller than parameter Cycle time warning limit
of the F-runtime group.

3.3. Priority:
Define a priority for the F-OB that is higher, if possible, than the priorities of the other
organization blocks.

4. Parameters of F-runtime group area:
Parameterize the maximum cycle times for the monitoring of the F-runtime group by the
controller.

4.1. Cycle time warning limit of the F-runtime group:
Define the maximum time that may pass between 2 calls of the F-runtime group before an
entry is written in the diagnostics buffer of the controller.

4.2. Maximum cycle time of the F-runtime group:
Define the maximum time that may pass between 2 calls of the F-runtime group before
the controller enters the STOP operating state.
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8.44

8.44.1

Configuring the drive controller

Assign a device name for the drive controllers of your TIA project to be able to identify them in the
PROFINET network. Then, project and configure the process data transmission between the
controller and drive controller.

Then, project the PMC SUG6 safety module and configure the PROFIsafe addresses and the times for
the SS1 delay and PROFIsafe watchdog for it. Then, assign meaningful names for the two lowest-
value bits of the PROFIsafe control word and PROFIsafe status word.

Assigning device names

Assign a device name for your drive controllers to be able to identify them in the PROFINET network.

v You are in the TIA network view.

1.

Double-click on a drive controller of your PROFINET network.

= This switches you to the respective device view; the Inspector window shows the device
properties.

Inspector window > General tab:
Select General in the area navigation.

Name:
Assign a device name for the drive controller that corresponds to the PROFINET naming
conventions.

Device view:
Select the relevant drive controller and select Assign device name using its context menu.

= The Assign PROFINET device name window opens.
Click on Update list.
= All drive controllers are listed that were found in the subnet.

= Depending on the drive controller, the device type, IP address and MAC address are
displayed.

Mark the drive controller that you would like to name and click on Assign name.

The device name is assigned to the selected drive controller.

Information

I Alternatively, you can enter the device name in DriveControlSuite in parameter
A273[3] to [5]. This eliminates steps 4 to 6 in TIA Portal for assigning the device
name.

® Information

I Using Flash LED, you can identify which drive controller you have currently selected
if multiple drive controllers are found in the same subnet.

As an alternative, you can identify the drive controller by its MAC address. The MAC
address of the drive controller can be read off in parameter A279 PN MAC
addresses in DriveControlSuite (PROFINET wizard > Diagnostics).
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8.44.2 Projecting PZD transmission
Project the transmission of the process data for each axis using the desired process data module for
Drive Based applications or the desired telegram for the PROFIdrive application.
8.44.21 Projecting the process data module
Define the data volume for the PZD transmission of the PROFINET communication by projecting a
process data module for each axis.
v" You are in the TIA network view; the hardware catalog is open.
1. Double-click on a drive controller of your PROFINET network.
= This switches you to the respective device view; the inspector window shows the device
properties.
2. Hardware catalog:
Select Module > Cat 1: Process data modules (PZD), all consistent.
3. Select a process data module with a data volume that corresponds at least to your process data
map in the drive controller.
4. Drag and drop the selected module into the device overview of the drive controller at slot 1
provided for this.
5. If you are using a double-axis controller, repeat the process for the second axis and slot 2.
= The input and output addresses of the drive controller are generated automatically.
® Information
I For the project configuration of the PMC SU6 safety module, proceed as described
in Configuring PROFIsafe settings [[L|]]46].
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8.44.2.2 Projecting a standard telegram

Project one standard telegram per axis.

® Information

1 For double-axis controllers, note that mixed operation of the PROFINET RT and
PROFINET IRT transmission methods is not possible. For example, if you project
standard telegram 1 in AC1 for axis A and standard telegram 5 in AC4 for axis B,
standard telegram 1 is ignored.

v’ You are in the TIA network view; the hardware catalog is open.

1. Double-click on a drive controller of your PROFINET network.

= This switches you to the respective device view.

2. Hardware catalog:
Select Module > PROFIdrive modules.

3. Drag and drop the PROFIdrive modules module into the device overview of the drive controller
at slot 1.

4. Hardware catalog:
Select Module > Submodules.

5. Select a telegram.

6. Drag and drop the selected standard telegram into the device overview of the drive controller at
slot 1 2.

7. If you want to use an additional telegram, select it in the hardware catalog.

8. Drag and drop the selected additional telegram into the device overview of the drive controller at
slot 1 3.

9. If you are using a double-axis controller, repeat steps 2 through 8 for the second axis and for
slots 2, 2 2 and 2 3. Project a telegram for the second axis even if you are not using it.

= You have configured the telegrams.

® Information

1 If you project additional telegram 900, define the additional process data that is to be
transferred to the controller in DriveControlSuite via the parameters A92 (RxPZD)
and A96 (TxPZD). Elements [0] to [11] are used for axis A parameters and elements
[12] to [23] for axis B parameters. A data length of 12 bytes each is available for the
receive and transmit process data.
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8.44.3 Configuring PZD transmission

For process data transmission, configure the cycle time for the data exchange as well as the
watchdog time for the monitoring of PROFINET communication between the controller and drive

controller.

v" You are in the TIA network view.

1. Double-click on a drive controller of your PROFINET network.

= This switches you to the respective device view; the inspector window shows the device
properties.

2. Inspector window:

In the area navigation, select PROFINET interface [X1] > Advanced options > Real-time settings
> |O cycle.

3. Update time:
Configure the cycle time in which the controller and drive controller exchange data.

3.1.

3.2.

3.3.

Calculate update time automatically:
If the cycle time is to be calculated automatically, select this option.

Set update time manually:
If you want to set the cycle time manually, select this option and specify the desired time.

Adapt update time when send clock changes:
If you have set the cycle time manually and if the ratio between cycle time and
transmission cycle is to remain constant, also select this option.

4. Watchdog time area:
Configure the watchdog time for monitoring the PROFINET communication.

41.

4.2.

1

Accepted update cycles without 10 data:
Enter the number of permitted cycles after which the PROFINET watchdog is triggered in
case of an interruption in PROFINET communication.

Watchdog time:
The watchdog time for PROFINET communication is calculated automatically based on

the cycle time and the permitted cycles without data exchange and must not exceed 1.92
seconds.

Information

The application-dependent cycle time of the drive controller can be read off in
parameter A150 Cycle time in DriveControlSuite.
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8.44.4 Setting a drive controller synchronously

Configure the following settings for clock synchronization via PROFINET IRT if you want to implement
control in application class 4. For other application classes, this step is omitted.

v’ You are in the TIA network view.

1. Double-click on a drive controller of your PROFINET network.

= This switches you to the respective device view; the Inspector window shows the device
properties.

2. Inspector window > General tab:
Select PROFINET interface > Advanced options > Isochronous mode in the area navigation.

3. Isochronous mode for local modules area > Isochronous mode:
Activate the option.

4. Detail overview area:
Activate the submodule with the inserted telegram in the Isochronous mode column to assign the
synchronized operation to the telegram.

5. Ifitis a double-axis controller, activate the second submodule with the inserted telegram.

= The times are recalculated and entered in the Isochronous mode for local modules area. The
transmission cycle is taken from the GSD file.

= You have configured the drive controller for synchronized operation.

8.4.4.5 Configuring PROFIsafe settings

After you complete configuration of the basic PROFINET settings, continue with the configuration of
the PROFIsafe settings. Project and configure the PMC SUG6 safety module, specify the SS1 delay
time and assign a meaningful name for the relevant bit of the PROFIsafe control word and PROFIsafe
status word.

8.44.51 Projecting the PMC SU6 safety module

Project the PMC SUG6 safety module for the drive controller in order to then be able to configure the
safety-related settings.

v" You are in the TIA network view; the hardware catalog is open.
1. Double-click on the drive controller for which you want to project the PMC SU6 safety module.
= This switches you to the respective device view.

2. Hardware catalog:
Select Module > Safety module (XP).

3. Drag and drop the Safety module (XP) safety module into the device overview of the drive
controller at the bottom slot provided for this.

= The PMC SU6 safety module is projected for the drive controller.

® Information

1 For each drive controller, you can project only one safety module for the intended
slot (single-axis controller: slot 2, double-axis controller: slot 3). Safety module (XP)
supports the latest PROFIsafe version 2.61, while Safety module (LP, old) supports
PROFIsafe version 2.4.
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8.4.45.2 Configuring the PROFIsafe addresses

Configure the PROFIsafe destination address for the PMC SU6 safety module and store the
PROFIsafe source addresses of the controller.

v" You are in the TIA device view of the drive controller.
1. Select the safety module in the device overview of the drive controller.
= The inspector window shows the device properties of the safety module.

2. General tab:
Select PROFIsafe in the area navigation.

3. PROFIsafe area > F_Source_Add:
Enter the PROFIsafe address of the controller (Central F-source address).

4. PROFIsafe area > F_Dest_Add:
Enter the PROFIsafe address of the safety module (S41 PROFIsafe address).

= The PROFIsafe addresses for the PMC SUG6 safety module are configured.

Py Information

1 In TIA Portal, make sure that the PROFIsafe source addresses of the F-CPU match
in the device configuration of the controller and in the device configuration of the
drive controller (controller: Central F-source address; drive controller:
F_Source_Add).

® Information

I The PROFIsafe destination address F_Dest Add, which you set using the DIP
switch on the drive controller and store in TIA Portal, can be read off in parameter
S41 PROFIsafe address in DriveControlSuite (Monitoring: PROFIsafe wizard).
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8.4453 Configuring PROFIsafe communication

Enter the checksum for the monitoring of PROFIsafe communication that you have calculated in
DriveControlSuite and define the watchdog time after which an STO is triggered in case of an
interruption in PROFIsafe communication. Define the SS1 delay after which the drive controller is
stopped when an SS1-t is triggered.

Configuring the PROFIsafe watchdog and checksum

v" You are in the TIA device view of the drive controller.

v" The inspector window shows the device properties of the safety module.

1. General tab:
Select PROFIsafe in the area navigation.

2. PROFlsafe area > F_WD_Time:
Enter the watchdog time after which an STO is triggered in case of an interruption in PROFlsafe
communication.

3. PROFlsafe area > F_iPar_CRC:
Enter the value for the checksum of the F_iPar parameter that you have calculated based on the
SS1 delay time in DriveControlSuite.

1

Information
Assign a sufficiently large value for the PROFIsafe watchdog time F_\WD_Time.

Note the following condition:
S46 PROFIsafe watch dog time > A109 PZD-Timeout + S44 PROFIsafe data bus
turnaround time + 26 ms

Information

You need checksum F _iPar CRC for PROFIsafe communication. Calculate the
checksum based on the SS1 delay time in DriveControlSuite and transmit
F_iPar_CRC to the parameter of the same name in TIA Portal when configuring the
safety module.

If you make changes to the SS1 delay time, you must recalculate F_iPar_CRC and
store it in the device configuration of the safety module in TIA Portal.
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Configuring SS1 delay time
Enter the delay after which the STO safety function is active when triggering an SS1-t.

v You are in the TIA device view of the drive controller.

v" The inspector window shows the properties of the safety module.

1. General tab:
Select Module parameters in the area navigation.

= The settings for the module parameters open.

2. Failsafe organization block area > SS1 Delay Time:
Enter the SS1 delay time as a multiple of 10 ms.

® Information

I Enter the SS1 delay time as a multiple of 10 ms. An SS1 Delay Time of 100
corresponds to 1 s (100 x 10 ms = 1 s).

Assign a larger value for SS1 Delay Time than for the quick stop time of the drive
controller. The reserve should generally be 10% and should not fall below 50 ms.

Information

I If you make changes to the SS1 delay time, you must also recalculate F_iPar CRC
with the changed value and store it in the device configuration of the safety module
in TIA Portal.
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8.4.4.5.4 Configuring PROFlsafe status word and PROFIsafe control word

You can make programming the safety program easier by assigning meaningful names for the
relevant bits of PROFIsafe status word S_ZSW1 and PROFIsafe control word S_STW1.

v’ You are in the TIA device view of the drive controller.

v" The inspector window shows the properties of the safety module.

1. Switch from the General tab to the |O variables tab.

= The inspector window shows you the control and status word for the safety functions.

2. Name column:
Assign a meaningful name for the two lowest-value bits of the status word (address %l).

2.1. Assign a meaningful name for bit O of the status word that shows whether the STO safety
function is active, e.g. STO IsActive.

2.2. Assign a meaningful name for bit 1 of the status word that shows whether the SS1 safety
function is active, e.g. SS1 IsActive.

3. Name column:
Assign a meaningful name for the two lowest-value bits of the control word (address %l).

3.1. Assign a meaningful name for bit 0 of the control word that requests the STO safety
function, e.g. STO Request.

3.2. Assign a meaningful name for bit 1 of the control word that requests the SS1 safety
function, e.g. SS1 Request.

8.4.5 Configuring the control

Next, configure the control of the application according to your use case by using technology objects
or function blocks.

For further information on configuring the control and on technology objects and function blocks, refer
to the corresponding PROFIdrive application manual (see Further information [69]).

WARNING!

Injury to persons and material damage due to axis movement!

Bits 2—7 of PROFIsafe control word S_STW1 are reserved for internal functions of
the safety module.

= Make sure that bits 2—7 of PROFIsafe control word S_STW1 have the value 0.
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8.4.6 Transmitting the configuration
Transmit the configuration of your TIA project from your PC to your controller.
v" You have fully mapped and parameterized your PROFINET network in the TIA project.
1. Project navigation > Devices tab:
Select the folder of the controller in question.
2. Select Online > Advanced download to device in the menu bar.
= The Advanced download window opens.
3. Select target device area:
Select Show all compatible nodes and click on Start search.
= All controllers are listed that were found in the subnet.
4. Select the controller where you would like to transfer the configuration and click on Download.
= The Software synchronization before downloading to a device window opens.
5. Click on Continue without synchronizing.
= The Preview download window opens.
6. Click on Download.
= The configuration is transmitted to the selected controller and the Results of the download
process window opens.
7. Click on Finish.
= The download process is complete; the configuration was transmitted successfully to the
controller.
® Information
I If there is an online connection, you can identify which controller you have currently
selected using Flash LED if multiple controllers are located in the same subnet.
Information
In DriveControlSuite, parameter A271 provides information about the state of the
drive controller in the PROFINET network. If the application selected in
DriveControlSuite does not match the inserted module in TIA Portal, the status
6: Configuration Application / PROFINE does not fit is output there.
= In this case, make sure that the device control and the PROFIdrive application
are projected in DriveControlSuite and that a PROFIdrive module has been
inserted in TIA Portal.
® Information
I Parameter A272 in DriveControlSuite provides information about the submodules
projected in TIA Portal (display format: XXX YYY ZZZ; XXX = submodule ID
(telegram no.), YYY = TxPZD data length in bytes, ZZZ = RxPZD data length in
bytes).
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8.4.7 Testing communication

Check the communication between the controller and drive controllers of your PROFINET network
using the diagnostics buffer of the controller.

v~ You have transferred the configuration to the controller.

1.

Project tree > Devices tab:
Open the folder of the relevant controller.

Double-click Online & diagnostics.
= This switches you to the respective device view.
Select Online access in the area navigation.

Online access area:
Click on Go online.

= An online connection to the selected controller is being established.
In the area navigation, select Diagnostics > Diagnostics buffer.

Results area:
Check the events in the diagnostics buffer for possible errors and correct their causes if
necessary.

The connection between the controller and drive controller is projected and a data exchange
between the nodes in the PROFINET network is possible.

® Information

1

If there is an online connection, you can identify which controller you have currently
selected using Flash LED if multiple controllers are located in the same subnet.

Information

Also observe the control and status information in the F-1/0 DB of the safety module,
such as for reintegration of the safety module after starting up the safety system
(bit 4 ACK_REI).

The F-I/0O DB of the safety module can be found in the Program blocks folder >
System blocks > STEP 7 Safety > F-1/0O DBs in the project navigation in TIA Portal.

® Information

I The safety technology configuration is completed. Continue by starting the
programming of the safety program (main safety block).

Then, check the safety functions and document the results in a test report.
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8.5 Checking safety functions
The PMC SU6 safety module is a safety component in the sense of the Machinery Directive in
accordance with Annex V. It guarantees functional safety, e.g. protection against errors in the
hardware and firmware. However, it does not guarantee the safety of the entire process or the safety
of the configuration.
The machine manufacturer must check and verify the functional capability of the safety functions
used. The safety functions may only be checked by qualified personnel. The result of the check must
be documented in a test report.
The check of the safety function must be performed:
After initial commissioning
After changing the configuration of the safety functions
After exchanging the safety module or drive controller
A complete check includes:
The proper execution of the safety functions used in the PMC SU6 safety module
The proper execution of the overall safety function (e.g. combination and integration of safety
functions)
A parameter check
The check is based on:
The requirements for the safety functions of the PMC SU6 safety module from the risk analysis of
the machine or process
The description of the PMC SUG6 safety module and its safety functions in accordance with this
manual
All safety-related parameters and values of the safety functions used
The test report must contain the following:
A description of the application, including an image
A description of the safety-related components (including software versions) that are used in the
application
A list of the safety functions used
The results of all checks of these safety functions
A list of all safety-related parameters and their values
Checksums, test date and confirmation by the testing personnel
Safety tests in structurally identical applications may be performed as an individual type test of the
identical application, provided that it can be ensured that the safety functions are configured in all
devices as intended.
Py Information
I The test must be repeated and it must be noted in the test report if parameters were
changed that have an influence on the safety functions.
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9

9.1

9.1.1

Diagnostics

In the event of fault, the various diagnostic options described below are available.

LED display

The drive controllers feature diagnostic LEDs that visualize the state of fieldbus communication and
the states of the physical connection.

PROFINET state

There are 2 LEDs on the front of the drive controller that provide information about the connection
between controller and drive controller and about the state of the data exchange. This information can
also be read out in parameter A271 PN state.

Fig. 6: LEDs for the PROFINET state

1 Red: BF (bus error)
2  Green: Run

Red LED

Conduct

Description

Off

No error

Rapid flashing

Data exchange with controller
not active

JLLLl
|

On

No network connection

Tab. 6: Meaning of the red LED (BF)

Green LED Conduct Description
Off No connection
| | | | Single blink Connection is set up to

controller

Single blink, inverse

Controller activates DHCP
signal service

LI B B
- N N B
|

Flashing Existing connection to
controller; data exchange
expected

On Existing connection to controller

Tab. 7: Meaning of the green LED (Run)
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9.1.2 PROFIsafe status

If the drive controller includes the PMC SU6 safety module, the STO and SS1 safety functions are
activated via PROFIsafe. In this case, an LED on the front of the device provides information about
the status of PROFIsafe communication. This information can also be read out in parameter

S40 PROFIsafe state.

Fig. 7: LED for the PROFIsafe state

1 Green: PROFlsafe

Green LED Conduct Description

Off Initialization

Flashing Ready for parameterization by
controller (F-CPU)

On Normal operation

Rapid flashing with 1x flash Error in the safety-related
communication settings

Rapid flashing with 2x flash Error in the safety-related
application settings

-l N H N B
|
(111710 E——
(111 I —
I" | | . ‘. . Rapid flashing with 3x flash Incorrect PROFIsafe

destination address

Rapid flashing with 5x flash Interruption of the PROFIsafe
connection (watchdog error)

Rapid flashing with 6x flash Error in the transmission of the
PROFIsafe data (CRC error)

Tab. 8: Meaning of the green LED (PROFIsafe status indicator in accordance with IEC 61784-3)

® Information

I Parameter S40 PROFIsafe state contains detailed information about the PROFIsafe
communication status. The value of S40 can be read off in PROFINET wizard >
Monitoring: PROFIsafe in DriveControlSuite.
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9.1.3 PROFINET network connection

The Act. and Link LEDs at X200 and X201 on the top of the device indicate the state of the
PROFINET network connection.

Fig. 8: LEDs for the state of the PROFINET network connection

A W N -

Green: Link at X201
Yellow: Activity at X201
Green: Link at X200
Yellow: Activity at X200

Off

No network connection

On

Network connection exists

Tab. 9: Meaning of the green LEDs (Link)

Off

No data exchange

- N . .

Flashing

Active data exchange with controller

Tab. 10: Meaning of the yellow LEDs (Act.)
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9.2

Parameters

The following parameters are available for diagnosing the safety technology in combination with the
PMC SUG6 safety module.

E54 Information safety module

E67 STO state

S41 PROFlsafe address

S42 Safety control word 1

S43 Safety status word 1

S44 PROFIsafe data bus turnaround time
S45 PROFIsafe diagnosis

S46 PROFIsafe watch dog time

S47 PROFIsafe SS1-time

S130 Run time

® Information

I In DriveControlSuite, the diagnostic parameters for the PMC SU6 safety module are

provided at a glance by PROFINET wizard > Monitoring: PROFIsafe.
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9.3 Events

The drive controller has a self-monitoring system that uses test rules to protect the drive system from
damage. Violating the test rules triggers a corresponding event. There is no possible way for you as
the user to intervene in some events, such as the Short/ground event. In others, you can influence the
effects and responses.

Possible effects include:
Message: Information that can be evaluated by the controller

Warning: Information that can be evaluated by the controller and becomes a fault after a defined
time span has elapsed without the cause being resolved

Fault: Immediate drive controller response; the power unit is disabled and axis movement is no
longer controlled by the drive controller or the axis is brought to a standstill by a quick stop or
emergency braking

Depending on the event, there are various measures you can take to rectify the cause. As soon as
the cause has been successfully rectified, you can usually acknowledge the event immediately. If the
drive controller has to be restarted, a corresponding note can be found in the measures.

ATTENTION!

Damage to property due to interruption of a quick stop or emergency braking!

If, when executing a quick stop or emergency braking, a fault occurs or STO is
active, the quick stop or emergency braking is interrupted. In this case, the machine
can be damaged by the uncontrolled axis movement.

Information

To make it easier for control system programmers to set up the human-machine
interface (HMI), you can contact Pilz Support at support@pilz.com for a list of events
and their causes.
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9.3.1 Event 50: Safety module

The drive controller has a fault:

The power unit is disabled and axis movement is no longer controlled by the drive controller

The behavior of the brakes depends on the configuration of the safety module

® Information

I A rising edge for the release override signal (source: F06) is expected in the Switch
on disabled, Ready to switch on, and Switched on states (E48) so that the brake is

released.

Cause

Check and action

2: Wrong safety module

The projected E53 safety
module does not match the
E54[0] detected by the
system

Check the project configuration and
drive controller and correct the project
configuration or exchange the drive
controller if necessary; fault cannot be
acknowledged

3: Internal error

Defective safety module

Exchange drive controller; fault cannot
be acknowledged

20: Safety control word
Error

PROFIsafe control word
S42, bits 2-7 #0

Check the configuration and
programming in TIA Portal and correct
it if necessary; value must be 0

Tab. 11: Event 50 — Causes and actions
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9.3.2 Event 70: Parameter consistency

The drive controller has a fault:

The power unit is disabled and axis movement is no longer controlled by the drive controller

The behavior of the brakes depends on the configuration of the safety module

Information

I A rising edge for the release override signal (source: F06) is expected in the Switch
on disabled, Ready to switch on, and Switched on states (E48) so that the brake is

released.

® Information

1 The event is only triggered if the checking rules for Enable-on are violated.

Cause

Check and action

PMC SUG6 option:
15: Safety watchdog time

Monitoring of PZD timeout
deactivated

Check the PZD timeout in the drive
controller and activate it if necessary
(A109 = 0 or 65535)

Ratio of PROFIsafe
watchdog time to PZD
timeout too small

Check the PROFIsafe watchdog time
in TIA Portal and PZD timeout in the
drive controller; if necessary, increase
the watchdog time or reduce the PZD
timeout (condition: PROFIsafe
watchdog time > PZD timeout +
PROFlsafe data bus runtime + 26 ms;
S46 > A109 + S44 + 26 ms)

Tab. 12: Event 70 — Causes and actions

Manual PMC SU6 safety module
1006910-en-US-02

Pilz | 60



More information on PROFIsafe, safety functions and PMC SU6?

10

10.1

More information on PROFIsafe, safety functions and
PMC SU67?

This chapter summarizes the important terms, relationships and measures regarding PROFIsafe, the
STO and SS1 safety functions and the PMC SU6 safety module.

PROFIlsafe

A safety protocol known as PROFIsafe exists in parallel with the Ethernet system PROFINET for the
transmission of safety-related messages between PROFIsafe-capable devices in a network. The
protocol is internationally standardized in accordance with the IEC 61784-3 standard. The design of
PROFIsafe is based on the black channel principle.

Secure communication

During each PROFlsafe cycle, a safety controller (F-host) sends safety-related data to a drive
controller (F-device) and simultaneously starts a watchdog timer. The drive controller acknowledges
the received data and also begins runtime monitoring via a watchdog timer. The controller receives
and processes the acknowledgment from the drive controller and stops the watchdog timer. If the
data has been fully processed, the controller generates a new data packet.

Unique addressing
It must be possible to identify each drive controller using a unique PROFIsafe destination address.

The address is assigned to the drive controller using a DIP switch. A valid address is in the address
range 1-254 (8 bit; addresses 0 and 255 must not be assigned).
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10.1.1

PROFIsafe telegram 30

For PROFIsafe communication between the controller and drive controller, PROFIsafe telegram 30 is
used. Input data consists of 7 bytes and output data of 7 bytes, of which the first 2 bytes are assigned
by the PROFIsafe control word (S_STW1) and PROFIsafe status word (S_ZSW1). The other 5 bytes
are assigned by the PROFIsafe trailer, which contains the management information for PROFIsafe
communication and is automatically read and written by the controller.

PROFIsafe control word (S_STW1)

The PROFIsafe control word is sent by the controller to the drive controller and contains information
about whether the STO or SS1 safety functions are to be triggered in the drive controller. For
triggering the safety functions, bit 0 and bit 1 of the control word are reserved and must be actuated
with inverse logic.

Safety function Bit Value

STO Bit 0 0 = Trigger STO

1 = Do not trigger STO

SS1 Bit 1 0 = Trigger SS1

1 = Do not trigger SS1

- Bits2 -7 Reserved; value must be 0

PROFIsafe status word (S_ZSW1)

The PROFIsafe status word is sent by the drive controller to the controller and contains information
about whether the STO or SS1 safety functions are active in the drive controller. Bit 0 and bit 1 of the
status word are reserved for the status of the safety functions.

Safety function Bit Value

STO Bit 0 0 = STO not active
1=S8TO active

SS1 Bit 1 0 = SS1 not active
1 =S8S1 active
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10.2

Safety functions

The PMC SUG6 safety module supports the Safe Torque Off (STO) and Safe Stop 1 (SS1-t) safety
functions. In order to move the axis, the safety controller must set both the STO and SS1 control bit of
the drive controller. If only one of the two control bits is set, the drive controller remains in a safe state
(STO active).

The safety functions relate to the device and are not axis-specific. This means that for multi-axis
controllers, only the entire drive controller can be set to a safe state, not individual axes.

10.2.1 Safe Torque Off — STO
1
STO
| >
t
A
n
Speed
t
A
On
Torque
on Motor o
t
1
STO State
1 -
t
Fig. 9: STO function principle in accordance with ETG.6100.2
STO in accordance with EN 61800-5-2 corresponds to stop category 0 in accordance with EN 60204.
STO is the most fundamental drive-integrated safety function. STO prevents energy that generates
torque from acting on the connected motor and prevents unintentional start-up. The goal is to safely
eliminate material damage and injuries to persons caused by a rotating or unintentionally activated
motor.
The use of STO is always suitable if the motor comes to a standstill on its own in a sufficiently short
time period due to load torque or friction or in an environment in which motor coasting does not have
safety-related implications.
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10.2.2 Safe Stop 1 — SS1-t
1
SS1
I -
t
A
n
Speed
to B T sS1 o t1 t
A
On
Torque
on Motor _
t
1
SS1 State
| >
t
1
STO State
| [ >
t
Fig. 10: SS1-t function principle in accordance with ETG.6100.2
ty SS1 activation
t, STO activation
T_SS1 SS1 delay time
SS1 in accordance with EN 61800-5-2 corresponds to stop category 1 in accordance with
EN 60204-1.
In the case of SS1-t, the switch-off happens after a configurable amount of time.
The SS1-t safety function enables controlled stopping of a motor and switches it to a torque-free state
after the parameterized SS1 delay time has passed, i.e. the STO safety function is activated. STO is
triggered after a time delay, regardless of whether the motor has already reached a standstill.
WARNING!
Increased overrun distance! Residual motion!
The safety module cannot prevent a failure of the functional part of the drive
controller (e.g. during a controlled stop) while the SS1-t safety function is executed.
Therefore, SS1-t cannot be used if this failure could cause a dangerous situation in
the end application. Observe this during project configuration.
In the event of an error in the power unit of the drive controller, static energization of
the motor is possible despite active STO. In this case, the motor shaft can move by
an angle of up to 360° + (p x 2).
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® Information

I Be aware that the drive controller continues to follow the set values of the controller
during the SS1 delay time, which enables controlled stopping in multi-axis
applications.

The SS1 delay time T_SS1 is a safety-related parameter. The value of T_SS1 is transmitted from the
safety controller to the drive controller during the initialization of communication.

In DriveControlSuite, the value of T_SS1 is shown in parameter S47 PROFIsafe SS1-time.
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10.3 PMC SUG6: Assign the PROFIsafe destination address

To be able to identify the PMC SU6 safety module uniquely in the PROFIsafe network, you must
manually assign a PROFIsafe destination address to it from the address range 1-254 using the S12
DIP switches on the top of the drive controller. Addresses 0 and 255 are invalid, i.e. when address 0
or 255 is assigned, the value is ignored and the PMC SU6 safety module remains in the STO state.

P Information

I The drive controller must be switched off before you assign the address for the PMC
SU6 safety module using the S12 DIP switches. The drive controller has to be
restarted to apply the address.

Assigning the address using S12 DIP switches

The DIP switches for assigning the address are located on the top of the drive controller. The address
is based on the values from the DIP switches that are switched ON. The following graphic shows DIP
switches S12.2 and S12.4 in the ON state. Address 10 results from the associated values 2 and 8 of
the DIP switches for the PMC SU6 safety module.

il B (Fedll e ‘ |

Fig. 11: PMC SU6 — S12 DIP switches

S12 DIP switches 1 2 3 4 5 6 7 8
Value (address) 1 2 4 8 16 32 64 128

Tab. 13: S12 DIP switches and values

Checking the PROFIsafe destination address

The PROFIsafe destination address assigned by you for the PMC SUG6 safety module can be checked
using parameter S41 PROFIsafe address in DriveControlSuite.
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10.4 Safety system time

Controller
(F-host)
I I

Communication

Safe Drive controller
Sensor - . .
input (F-device)
=—Reaction time—#= & Reaction time—# 4—Reaction time—# =—Reaction time—#

Safety system time

Fig. 12: Reaction times and safety system time

The safety system time is understood as the time span that passes from the request of a safety
function to a sensor until the safety function is triggered on the drive controller.

The safety system time depends on the reaction times as well as communication and transmission
times of the individual system components.

The reaction and communication times are produced from the following process:

Sensor:
Provides the request signal

Safe input:
Detects the request signal

Controller (F-host):
Evaluates the request signal and transmits the request signal to the drive controller

Drive controller (F-device):
Activates the safety function and deactivates it, if necessary (STO switch-off time); this process is
divided as follows:

* Processing in the control unit

» Transmission of the data packet to the PMC SU6 safety module
+ PMC SU6: Evaluation of the data packet

+ Switch-off time of the power unit

10.5 Watchdog time

To detect possible faults, PROFIsafe communication is monitored between the controller (F-host) and
drive controller (F-device) by a PROFIsafe watchdog. As soon as a safety telegram has been sent,
both the controller and drive controller start the watchdog time. If the controller or drive controller do
not receive a corresponding response message before the watchdog time runs out, the respective
device switches into a safe state. The watchdog time is taken into account when calculating the worst
case response time.

The watchdog time is parameterized individually for each drive controller in the controller.

In TIA Portal, a global watchdog time of 100 ms is set by default. If you would like to change the
watchdog time, switch to the device configuration of the respective safety module in TIA Portal.
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1 Appendix
11.1 Standard telegrams
1.1.1 Standard telegram 30: Process data
The following tables show the structure of PROFIsafe standard telegram 30 of the PMC SU6 safety
module.
The mapping of the process data is specified by the controller.
Py Information
I More information about PROFIsafe telegram 30 can be found in the chapter
PROFIsafe telegram 30 [[L[]|62].
Byte Data type Name Comment
0-1 WORD Safety control word 1 Parameter S42
(S_STWH1)
2-6 - PROFlsafe trailer -
Tab. 14: PROFIsafe RxPZD standard telegram 30
Byte Data type Name Comment
0-1 WORD Safety status word 1 Parameter S43
(S_ZSW1)
2-6 - PROFlsafe trailer -
Tab. 15: PROFIsafe TxPZD standard telegram 30
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11.2

Further information

The documentation listed below provides you with further relevant information on the drive controllers.
The current status of the documentation can be found at:

https://www.pilz.com/en-INT.

Title Documentation Contents ID
PMC SC6 drive controller Manual System design, technical data, 1005343
project configuration, storage,
installation, connection,
commissioning, operation, service,
diagnostics
Multi-axis drive system with | Manual System design, technical data, 1005342
PMC SI6 and PMC PS6 project configuration, storage,
installation, connection,
commissioning, operation, service,
diagnostics
PROFINET communication | Manual Electrical installation, data transfer, | 1006907
— PMC SC6, PMC SlI6 commissioning, diagnostics, detailed
information
PROFIdrive application — Manual Project configuration, configuration, | 1006911
PMC SCe6, PMC Sl6 parameterization, function test,
detailed information
Drive Based application Manual Project configuration, configuration, | 1006906
(DB) — PMC SC6, PMC SI6 parameterization, function test,
detailed information
Drive Based Synchronous Manual Project configuration, configuration, | 1006908
application (DBS) — PMC parameterization, function test,
SC6, PMC SlI6 detailed information
Drive Based Center Winder | Manual Project configuration, configuration, | 1006912
application (DBCW) — PMC parameterization, function test,
SC6, PMC SlI6 detailed information

The standards listed below are relevant for the PMC SU6 safety module described in this

documentation:

PROFIBUS Nutzerorganisation e. V. (PNO), 2019. Amendment PROFIdrive on PROFIsafe —
Interface for functional safety. Technical specification for PROFIBUS and PROFINET. Version 3.1.0,

February 2019.

PROFIBUS Nutzerorganisation e. V. (PNO), 2014. PROFIsafe — Profile for Safety Technology on
PROFIBUS DP and PROFINET I0O. Technical specification for PROFIBUS and PROFINET.

Version 2.6.1, August 2014.

PROFIBUS Nutzerorganisation e. V. (PNO), 2007. PROFIsafe — Profile for Safety Technology on
PROFIBUS DP and PROFINET I0O. Technical specification for PROFIBUS and PROFINET.

Version 2.4, March 2007.

PROFIBUS Nutzerorganisation e. V. (PNO), 2015. Profile Drive Technology — PROFIdrive Profile.
Technical specification for PROFIBUS and PROFINET. Specification. Version 4.2, October 2015.

PROFIBUS Nutzerorganisation e. V. (PNO), 2010. Overview and guidance for PROFINET
specifications. Technical specification for PROFINET. Version 2.3, October 2010.

PROFIBUS Nutzerorganisation e. V. (PNO), 2020. Application layer services for decentralized
periphery. Technical specification for PROFINET. Version 2.4MU1, March 2020.
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PROFIBUS Nutzerorganisation e. V. (PNO), 2020. Application layer protocol for decentralized
periphery. Technical specification for PROFINET. Version 2.4MU1, March 2020.

IEC 61784-1:2019 : Industrial communication networks — Profiles — Part 1: Fieldbus profiles.
Standard. Version 5.0, April 2019.

IEC 61784-1:2019 : Industrial communication networks — Profiles — Part 2: Additional fieldbus profiles
for real-time networks based on ISO/IEC/IEEE 8802-3. Standard. Version 4.0, April 2019.

Manual PMC SU6 safety module Pilz | 70
1006910-en-US-02



Appendix

11.3 Formula symbols
p - Number of pole pairs
Tu Year, a Mission time from production date until decommissioning
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11.4

Abbreviations
uC Microcontroller
CRC Cyclic Redundancy Check
GSD General Station Description data
IGBT Insulated Gate Bipolar Transistor
1/0 Input/Output
PL Performance Level
PLC Programmable Logic Controller
PROFINET Process Field Network
PWM Pulse Width Modulation
PDS(SR) Power Drive System(Safety Related)
PzD Prozessdaten (process data)
RxPZD Receive PZD (receive process data)
SIL Safety Integrity Level
SIL CL Safety Integrity Level Claim Limit
SRECS Safety-Related Electrical Control System
SRP/CS Safety-Related Part of a Control System
SS1 Safe Stop 1
SS1-t Safe Stop 1-time
STO Safe Torque Off
TIA Totally Integrated Automation
TxPZD Transmit PZD (transmit process data)
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Black channel principle

Technology that allows secure data to be
transmitted over unsecure network or bus lines.
Safety components can transmit safety-related data
regardless of hardware using a secure protocol that
tunnels through the underlying network channel.
Possible transmission errors are noted in the
standards IEC 61784-3 and IEC 61508.

Broadcast domain

Logical grouping of network devices within a local
network that reaches all nodes via broadcast.

Category

In accordance with DIN EN ISO 13849-1:
Classification of safety-related parts of a controller
regarding their resistance to faults and their
subsequent behavior in the event of a fault. A
category is attained through the structure and the
arrangement of parts, their fault detection and/or
their reliability. Possible category designations,
i.e. classifications, are B, 1, 2, 3, 4.

Control word

Parameter of the WORD data type (data width of
16 bits) that transmits control commands from the
controller to the drive controller.

F-CPU

Failsafe CPU in which a safety program can run in
addition to the user program.

F-device

A decentralized field device that exchanges safety-
relevant data cyclically with the F-host and is
managed and controlled by it. An F-device consists
of multiple modules and submodules. A drive
controller with the SU6 safety module for PROFIsafe
functionality is an F-device.

F-host

Data processing unit that runs the PROFIsafe
protocol and requests the exchange of safety-
relevant data with the F-slave.

F-OB

Failsafe block that is a component of the F-runtime
group and calls the main safety block cyclically.

F-runtime group

Failsafe runtime group that at least consists of an
F-OB and the main safety block and can include
other failsafe blocks as an option.

GSD file

Includes the technical features of a PROFINET 10
device (type, configuration data, parameters,
diagnostic information, etc.) in XML format in
accordance with the GSDML specification. A GSD
file serves as the configuration basis for project
configuration systems and is generally provided by
the respective device manufacturer.

Insulated Gate Bipolar Transistor (IGBT)

Bipolar transistor with insulated gate electrode.
Four-layer semiconductor component that is
controlled using a gate and combines the
advantages of bipolar and field-effect transistor. An
IGBT is primarily used in power electronics.

10 controller

Generally, a programmable logic controller that
controls automation tasks and regulates data
communication.

10 device

A decentralized field device that is assigned logically
to a PROFINET IO controller that manages and
controls it. An IO device consists of multiple
modules and submodules.

IPv4 limited broadcast

Type of broadcast in a network with IPv4 (Internet
Protocol version 4). The IP address
255.255.255.255 is entered as the destination. The
content of the broadcast is not forwarded by a
router, which limits it to the local network.

MAC address

Hardware address for unique identification of a
device in an Ethernet network. The MAC address is
assigned by the manufacturer and consists of a
3-byte manufacturer ID and 3-byte device ID.

Main safety block

Failsafe function block (F-FB) that is a component of
the F-runtime group and that contains the actual
safety program that is called up by the F-OB.

Mission time (TM)
In accordance with DIN EN 61800-5-2: Determined

cumulative length of operation of the PDS(SR)
during its overall service life.

Performance Level (PL)

In accordance with DIN EN ISO 13849-1: Measure
for the reliability of a safety function or a component.
The Performance Level is measured on a scale of a
— e (lowest — highest PL). The higher the PL, the
safer and more reliable the function in question is.
The PL can be assigned to a specific SIL. A
reversed inference from a SIL to a PL is not
possible.
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Probability of a dangerous failure per hour
(PFHD)

In accordance with DIN EN 61508/DIN EN 62061:
Average probability of a dangerous device failure
per hour. Together with PFH, one of the most
important bases for calculating the safety function
reliability of devices, the SIL.

Process data (PZD)

Control and status information that is time-critical
and transmitted in the PROFINET network cyclically
using telegrams. Depending on the view of the
respective node, a distinction is made between
receive PZD (RxPZD) and transmit PZD (TxPZD).

PROFIdrive

Standardized drive interface for PROFIBUS and
PROFINET open standard buses. It defines the
device behavior and procedure for accessing
internal device data for electrical drives on
PROFINET and PROFIBUS. The interface is
specified by PROFIBUS and PROFINET
International (PI) user organizations, and is specified
as the future-proof standard by standard

IEC 61800-7-303.

PROFINET

Open Ethernet standard of PROFIBUS
Nutzerorganisation e. V. (PNO) for automation.

PROFIsafe

Communication standard for safety standard

IEC 61508 that includes both standard as well as
fail-safe communication. The standard enables
reliable communication for PROFIBUS and
PROFINET open standard buses based on standard
network components, and is defined as the
international standard in standard IEC 61784-3-3.

PROFIsafe address

Address that uniquely identifies a node in the
PROFIsafe network. From the view of the controller,
the PROFIsafe source address of the controller and
the PROFIsafe destination address of the safety
module are distinguished. The address is generally
configured on the device itself, for example, using a
DIP switch.

Receive PZD (RxPZD)

Process data received by a node in the PROFINET
network.

Safe Stop 1 (SS1)

In accordance with DIN EN 61800-5-2: Procedure
for stopping a PDS(SR). With the SS1 safety
function, the PDS(SR) performs one of the following
functions: a) Triggering and controlling the motor
delay variable within defined limits and triggering the
STO function if the motor speed falls below a
specified limit value (SS1-d), or b) triggering and
monitoring the motor delay variable within defined
limits and triggering the STO function if the motor

speed falls below a specified limit value (SS1-r), or
c) triggering the motor delay and triggering the STO
function after an application-specific delay (SS1-t).
In this case, SS1(-t) corresponds to the time-
controlled stop in accordance with IEC 60204-1,
stop category 1(-t).

Safe Torque Off (STO)

In accordance with DIN EN 61800-5-2: Procedure
for stopping a PDS(SR). The STO safety function
prevents the motor from being supplied with any
energy that could cause rotation (or motion in a
linear motor). The PDS(SR) does not supply the
motor with any energy that could generate torque (or
force in a linear motor). STO is the most
fundamental drive-integrated safety function. It
corresponds to an uncontrolled stop in accordance
with DIN EN 60204-1, stop category 0.

Safety function

In accordance with DIN EN 61800-5-2: Function with
a certain safety-related capability that is carried out
in whole or in part by a PDS(SR) and with which the
safe state of a system is maintained or the
development of hazardous states in the system is
prevented.

Safety Integrity Level (SIL)

In accordance with DIN EN 61800-5-2: Probability of
a safety function failure. SIL is divided into levels

1 — 4 (lowest — highest level). SIL precisely
assesses systems or subsystems based on the
reliability of their safety functions. The higher the
SIL, the safer and more reliable the function in
question is.

Safety Integrity Level Claim Limit (SIL CL)

Maximum SIL that can be claimed, based on the
structural limitations and systematized safety
integrity of a SRECS subsystem. A SIL CL is
determined by the hardware fault tolerance (HFT)
and the safe failure fraction (SFF) of the
subsystems.

Safety module

Accessory for drive controllers that enables the use
of safety functions.

Status word

Parameter of the WORD data type (data width of
16 bit) that transmits the status information from the
drive controller to the controller.

STO switch-off time

Time span starting with the command to activate the
safety function on the safety module until the power
unit of the drive controller is safely switched off.

Transmit PZD (TxPZD)
Process data sent by a node.

Manual PMC SU6 safety module
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Watchdog

Function that is used for cyclical monitoring of
devices, connections or software. For example, a
watchdog is used to identify a communication failure
between the controller and drive controller and
activates in case of a timeout where no data
exchange has taken place between the devices
before the watchdog time expired.

Watchdog time

Time before the expiration of which a data exchange
between two instances or devices must have taken
place. If the watchdog time is exceeded without a
data exchange taking place, the watchdog is
triggered.

Worst case response time

Maximum time span required in order to switch off
the actuator in the event of an error.
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